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Winners of the Oklahoma
Press Association’s annual Bet-
ter Newspaper Contest will be
revealed at 10 a.m. Monday,
June 15 on OPA’s website and
Facebook page.

This will be OPA’s first-ever,
online awards presentation.
Winners of the following con-

tests will also be announced:
OPA Magazine Contest, ONF
Ray Lokey Memorial Award for
Excellence in Journalism, ONF
Joseph H. Edwards Outdoor
Writer of the Year, OGE-OPA
Photos of the Year, and ONG-
OPA Editorial and Column
Sweepstakes Awards.

Annual Award winners to be revealed June 15 at 10 a.m.

“Even though we will be
presenting these awards online
and not in person at the con-
vention, we hope you and your
staff join us to celebrate these
newspaper achievements,” said
Lisa Sutliff, OPA member ser-
vices director.

In April, the OPA Board of

Directors voted to move OPA’s
annual convention and awards
banquet to June 2021 but want-
ed to find a way to celebrate
award winners this summer.

Plaques and certificates will
be mailed or delivered as per-
mitted by coronavirus pandem-
ic restrictions.

Oklahoma journalists tell their stories
for the Coronavirus Storytelling Project

The first stories written by
journalists for the Coronavirus
Storytelling Project describe
personal struggles and tri-
umphs.

Eight stories are currently
available at OklahomaWatch.
org.

The Coronavirus Storytell-
ing Project was launched to

help journalists who are facing
difficult times.

Each week a journalist is
selected to write a first-person
story about the coronavirus or
challenges faced by journalists
during the outbreak. In return,
the journalist receives a one-
time $500 stipend.

Steve Lackmyer wrote about

Jenni Carlson, a sports columnist at The Oklahoman, started delivering
Meals on Wheels to the south side of Oklahoma City last year. During
the coronavirus pandemic, she is driving an extra route each week.
Photo by Chris Lambert/Ending Hunger OKC. Reprinted with permission.

the traumas and triumphs of his
three decades as a reporter for
The Oklahoman.

“ newspapers are not
immune to the economic chaos
wrought by the pandemic,”
Lackmyer wrote.

“Yet we continue. Over the
past few weeks, under great
strain and uncertainty, I've pro-
duced what I believe are some
of my best, most meaningful
stories in a long time.”

J. D. Meisner tells his story
of buying a community news-
paper right before the virus
outbreak.

“MaryLee, my wife and busi-
ness partner, and I closed on
the sale of the Cushing Citizen
in February,” wrote Meisner.
“The first month was success-
ful. We showed a fair profit and
prepared to move forward with
our business plan.”

Quoting Mike Tyson, Meis-
ner wrote, “Everybody has a
plan until they get hit.”

“On March 11, the Cushing
Citizen took it right on the chin
— and it hurt,” said Meisner.

Jenni Carlson, a sports
columnist for The OKlaho-
man, gives a personal account
of being a delivery driver for
Meals on Wheels OKC.

St. Luke’s United Method-
ist Church, Carlson’s home
church, began overseeing
OKC’s Meals on Wheels pro-
gram in July 2019.

With the number of peo-

ple needing meals rising, the
church put out an all-call for
more drivers during the pan-
demic.

“Being a sports columnist in
a time without sports, I added
another route to the one I was
already doing,” Carlson wrote.

Lindsey Chastain’s passion
is her community. Chastain is
editor of the Skiatook Journal.

“A pandemic does not stop
the need for community news,
even though it has stopped
seemingly everything else,”
Chastain wrote in her article.
“As journalists, we are tasked
with looking at the bad news
every day, weeding through
what is important and what is
real, and educating our com-
munities.

“But we are also tasked with
providing hope and bringing
the community together as
everyone shelters at home. We
let people know where they
can find help and provide a
haven where they can find accu-
rate and truthful information
amongst so many who do not.”

Traci Chapman, a freelance
journalist, wrote about the clo-
sure of The Edmond Sun and
the importance of community
newspapers and journalists.

“It’'s important to us to shine
a light on the happenings of
our community. That's why
we focus on everything, from

See Storytelling Project, Page 2
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BY OPA PRESIDENT RAY DYER, Co-Publisher of the El Reno Tribune

Here’s to a job well done

On April 28 we had to tell our pressman of almost a half-century we were going
to outsource our printing.

John Wiggins has been with the El Reno Tribune since 1972. He started in the
mailroom and later was trained to operate the press by the late Joe Keith.

John left for a couple of years to work for a printing operation in Oklahoma City.
He would grow tired of the commute and eventually said he wanted to return to the
Tribune. John and I had become friends. I told him I would run it by my dad.

Dad liked John, but he said he didn’t take people back once they had left. He
figured if they left once they could easily do it again. He didn’t want to invest in
people if they weren’t sure they wanted to be here.

I remember asking Dad what was the most expensive piece of equipment the
Tribune owned. Of course he said the press.

After having gone through a couple of less than adequate pressmen in the two
years since John had left, I figured I could press the issue. I remember suggesting
that it would probably be a good idea to have someone who had shown they could
run and maintain the press, as John had done before leaving.

I'm not sure why, but Dad agreed. He brought John back and, as they say, the
rest is history.

When brother Sean and I were talking with John he said the only real disap-
pointment he had in his career was not having reached 50 years in the newspaper
business. Forty-eight years. So close. But then, Sean reminded him that he had a
paper route while living as a kid in California. John had thrown papers in Hunting-
ton Beach for at least two or three years.

Fifty years. The pressman had made it.

Some people make a living by providing a service to people. Newspapers make
money by providing a connection to people. Our fragmented society has made it a
bit more difficult to make those connections.

For 48 years John helped us make the connection. He has had plenty of help.
People like Brett Barrett, Vicky Joyner, Judy Hampton, Glen Miller and Lyndsay
Bayne have been with us for many years. Before them came people like the late
Harry Schroeder, Floyd Sanders, Teri Grubbs and Marion Morefield. They were
and are the glue that holds it all together.

They are the people you work with. Each one of them with a story, a unique
personality. None any more so than the guy who drove the press for close to half a
century.

How many 67-year-old pressmen hop on a skateboard as the press comes to a
halt and glide to the other end of the 10-unit Harris to make the final adjustments?

Don’t tell OSHA.

April 28 we told John we had to shut the press down. It wasn’t planned, but the
news happened to fall on the 39th anniversary of our dad’s death.

Here’s to all the pressmen out there. Well done and thank you.

OKLAHOMA PRESS ASSOCIATION

CALENDAR OF EVENTS

Please check the OPA website,
https://okpress.com/events/event_list.asp
for a list of upcoming meetings and webinars.

FOR MORE INFORMATION ON EVENTS, visit the OPA website at www.OkPress.com
or contact Membership & Meetings Director Christine Frank at
(405) 499-0040, 1-888-815-2672 or email cfrank@okpress.com.

Bernie Heller named president
of Tulsa World Media Company

Bernie Heller has
been named presi-
dent of Tulsa World
Media Co. He also
will serve as direc-
tor of local sales and
marketing.

The announce-
ment was made by Nathan Bekke, oper-
ating vice president and vice president
of consumer sales and marketing for Lee
Enterprises, owner of the Tulsa World.

Heller, who has served as the World’s
vice president of advertising and mar-
keting, takes over the leadership posi-
tion formerly held by Gloria Fletcher,
publisher, who has left the company.

“Bernie is a dynamic leader dedicated
to the success of the local businesses
and communities we serve,” Bekke said
in an email to World employees. “He’s an
accomplished executive and ideally suit-
ed to lead our talented team in Tulsa.”

Heller joined Tulsa World Media Co.
in 2019. Prior to that, he served as
regional vice president of sales for local
advertising with McClatchy Corp.’s Car-
olinas region. His career also includes
positions as vice president and chief rev-
enue officer of The Charlotte Observer
in Charlotte, North Carolina, and vice
president of advertising for The State
Media Co. in Columbia, South Carolina.
He was formerly vice president of adver-
tising for The Dallas Morning News.

“I am thrilled to have the opportunity
to serve Tulsa World Media Co. in this
new role and honored to be a part of
Lee’s unwavering commitment to local
media,” Heller said. “Tulsa is a vibrant
community, and I've grown very fond of
this amazing city and the folks that call
it home.”

Heller has a son who is a student at
the University of South Carolina.

Edmond Sun shuts down, announces
merger with The Norman Transcript

In a front-page column on May 5, The
Edmond Sun announced it would be
merging with its sister newspaper, The
Norman Transcript, on May 6.

The column cited loss of advertising
revenue due to the current coronavirus
crisis as the catalyst to restructure.

“These are stressful times for you,

and for us,” the column said. “We thank
our Edmond Sun subscribers and adver-
tisers for their support over the years,
and ask that you continue to embrace
our journalism in The Norman Tran-
script.”

The Edmond printing facility will
remain operational.

StO rytel I I ng PI'O] eCt (continued from Page 1)

practical matters like city budgets and
school bond issues to local gatherings
and events like those of the high school
marching band, community garden and
Kiwanis,” Chastain wrote.

Jacob Threadgill, who spent more
than two years covering the Oklahoma
City restaurant scene for the Oklahoma
Gazette, looks at short-term and long-
term affects the pandemic will have on
restaurants.

Dawn Shelton, publisher of the
Luther Register News, a digital publica-
tion, writes about how her small town is
coping in the pandemic.

Berry Tramel, a columnist for The
Oklahoman, where he has worked since
1991, writes about being on furlough
when OSU football coach Mike Gundy
spoke.

“Mike Gundy went cuckoo, and I
was on furlough. Of all the rotten luck,”
Tramel wrote.

“We’ve gone more than a month
without sports, I make my living writ-
ing about sports, and when something

interesting finally happened, my pen
was gone, my laptop closed. In the wake
of the coronavirus pandemic, I was fur-
loughed from my job as a sports colum-
nist at The Oklahoman.”

If you haven’t taken a look at these
stories — or applied for a grant — visit
oklahomawatch.org.

The Coronavirus Storytelling Project
is a collaboration between three orga-
nizations to help Oklahoma journalists
who have been furloughed or displaced
as well as those in struggling commu-
nity news organizations.

The Oklahoma-based Inasmuch
Foundation pledged $50,000 to launch
the project in collaboration with the
Oklahoma Journalism Hall of Fame and
Oklahoma Watch.

Mike Sherman was named project
manager and editor of the Storytell-
ing Project. He worked many years in
Oklahoma, and was recently laid off as
deputy editor for sports at The Tampa
Bay Times.
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Owasso must comply with open records request

The City of Owasso must comply
with an Open Records Act request to
release a seven-year-old investigative
report involving a former city manager,
according to an Oklahoma Court of Civil
Appeals decision.

Patrick Ross, a former Owasso City
council member, had appealed a district
court finding that the city had properly
refused disclosure of a record known
as the “Fortney Report.” The report
probed misconduct complaints lodged
against former City Manager Rodney
Ray.

The appellate court ruled that the city
failed to show why the record should
not be made available and instructed the
district court to order the municipality
to comply with Ross’s Open Records
request, according to documents.

The court wrote that the ORA request
“involves specific questions why the City
Manager, who was accused of miscon-
duct, was granted a substantial sever-
ance package, paid for by the taxpayers
of Owasso, instead of being fired.

“In short, it is a ‘core’ Open Records
matter going directly to questions of

the legitimacy of the Mayor and City
Council’s good governance and use of
funds, and the citizens’ inherent political
power to inquire into these matters. City
identifies no valid privacy, state or public
interests in withholding the Report ... ”
Christopher Camp, an attorney who
represented Ross, said, “It's a win for
transparency, that’s for sure. It's a win
across the board for good governance.”
Ross died in January, Camp said.

County judge rejects call for investigative audit

A request from The Cordell Beacon
calling for an investigation audit of the
Cordell Public Schools Board of Educa-
tion was rejected by Washita County
District Attorney Angela Marsee.

The request alleged several viola-
tions of the state’s Open Meeting and
Open Records Acts between Jan. 13 and
March 19, 2020.

The Beacon alleged three violations

Elk City News shares

office reopening plan

The Elk City News recently shared
its “Phase One” reopening plan with
readers.

The lobby is available by appoint-
ment on weekdays between the hours
of 9 a.m. to 4 p.m. The office is also
available by phone and email.

“We strive to do our best to keep
our customers and staff members safe
as we begin the process of reopen-
ing,” said an article in the newspaper.

in the complaint filed March 19, 2020,
stemming from closed executive ses-
sions held during board meetings. The
complaint also alleged that the board
did not provide records requested by
the Beacon regarding a lawsuit between
Cordell Public Schools and Nurnberg
Roofing LLC.

At the time of the complaint, the
records had not been provided, but

on April 9 redacted copies of some of
the records were provided. Additional
redacted copies of records were pro-
vided April 23.

Marsee concluded that the actions of
the school board were consistent with
the provisions of both the Open Meeting
and Open Records Acts and declined a
formal investigation by the State Audi-
tor’s office.

State auditor’s office criticizes
district for open meeting violations

A circuit engineering district that pro-
vides shared services to 11 southwest-
ern Oklahoma counties violated several
state laws through its construction and
operation of an asphalt emulsion plant,
according to a recently released state
audit.

The asphalt emulsion plant was a joint
venture of Circuit Engineering District 7
(CED7) and the CED7 County Energy
District Authority.

The investigative audit by State Audi-
tor & Inspector Cindy Byrd’s office also
criticized CED7 for open meeting viola-
tions.

The state auditor’s office began its
investigative audit into the circuit engi-
neering district in 2017 after receiving
an audit request from four district attor-
neys who serve the region.

related to newspaper publishing.

You've Got Questions!

Can | photograph minors without consent?
Can police deny access to records by issuing a press release?
Should | alter my archives when a person demands it?
Can | report inaccurate testimony given in open court?
« What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA Legal Services Plan
members in recent months. Newspapers always need timely legal advice on issues

You should join OPA’S LEGAL SERVICES PLAN!

See www.OkPress.com/LSP or contact Mark Thomas
at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today!
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El Reno Tribune printing press makes final run

After more than 90 years, the E1 Reno
Tribune will not print in-house after May
29.

Tribune Co-Publisher Sean Dyer said
the Tribune will continue to produce two
print issues per week, but in June, the
newspaper will begin printing outside of
El Reno and Canadian County.

“The El Reno Tribune will continue to
cover the community and surrounding
area, focusing on delivering local news
and helping our advertisers reach their
audience,” Dyer said. “But the days of

Democrat-Journal

The Stilwell Democrat-Journal has
officially entered the digital age with a
new website.

The site, at www.stilwelldemocrat.
com, features breaking news, as well as
other features print subscribers have
come to expect.

“We've been in the planning and
development phases for quite some
time,” said Gary Jackson, publisher of
the Democrat-Journal. “It seems like an
opportune moment to launch it.

“This is especially needed during
this critical time of the pandemic so we
can provide up-to-date health informa-
tion, both locally and from the state.
Now readers don’t have to wait for our
print edition, once a week, for news.”

Jackson said he expects many of the
breaking news items to focus on the
evolving pandemic.

printing the paper in our own plant are
gone.”

The change will result in three
employees losing their jobs.

“This is the really hard part,” Dyer
said. “Some of our co-workers have been
with us for close to a half century. These
job cuts are no fault of their own.”

Among those impacted by the cuts is
award-winning pressman John Wiggins
who has been a part of the Tribune since
1972.

At one time, the Tribune provided

launches website

“We anticipate a lot of traffic on the
site,” he said. “Local, county and state
news will be our mainstay, as always.”

The website will also feature an
expanded photo section, weather,
sports, community news and obituaries,
as well as a community calendar with
local events.

“We are thrilled to finally be able to
provide our community with a website
that will serve as our newspaper’s digi-
tal arm,” Jackson said.

The site will be free to subscribers,
and for a limited time can be viewed at
no cost to all readers.

“Breaking news coverage, such as
stories about the current health emer-
gency, will always remain free and
accessible to the public,” said Jackson.

New reporter at Atoka County Times

Miranda Donihoo recently joined the
staff of the Atoka County Times.

In high school, Donihoo was involved
in the speech, drama and journalism
clubs.

She attended Murray State College,
graduating with an associate degree in
English, Donihoo continued her educa-

tion at Southeastern Oklahoma State
University where she received a bach-
elor’s degree in English.
Donihoo joined the Atoka County
Times’ team in March as a reporter.
She currently resides in the Wilson
community with her grandmother.

WIZARD!
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Go to miadwizard.com and see the magic for yourself!

service@metro-email.com
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print service for newspapers in Yukon,
Mustang, Piedmont, Okarche, Kingfish-
er and Hennessey, as well as the Sooner
Catholic and other publications. Dyer
said print margins have become “so
tight” the business model can no longer
be maintained.

The Tribune will continue to publish
an award-winning print product “because
people still want to hold a newspaper in
their hands,” Dyer said. It will also con-
tinue to expand on its digital information
products and services.

“Our world has changed and will
continue to do so and we will work to
change along with it, while still keeping
our commitment to provide accurate
news and information to the public,”
Dyer said.

The El Reno Tribune was established
in 1929. In 1943, Ray J. Dyer purchased
it from Eugene Pulliam of Indiana. The
newspaper has been owned and oper-
ated by the Dyer family since.

The Ada News’ annual pub-
lication highlighting the future
was a little different this year.

In addition to looking at the
future, Progress 2020 also took
a look at the present and the
disruptive effect caused by the
new respiratory virus, COVID-
19.

“This edition of Progress is,
like the year in which it is pub-
lished, different than most,”
wrote Ada News Editor Carl
Lewis. “We're still looking for-
ward, but we’re also chroni-
cling how we all got through
this time of stressful disruption
and social isolation.”

Locally owned businesses
were closed or their hours of
operation were altered and
schools abruptly closed.

“Life changed in the blink of
an eye,” wrote Lewis.

“Nothing about this moment
in time is even remotely nor-
mal. Nothing, that is, except for
Ada’s sense of community —
the connectedness that makes
Ada unique.”

The first section of Progress
2020 published April 10, with
the second section following
April 18.

The April 18 edition focused
on how the lives of children
from K-12 through college
and university students have
changed. It included stories from and
by East Central University students
who found themselves abroad when
life began to change, as well as stories
about school districts that reinvented
meal programs almost overnight to
make sure no student went without.

“The stories represent moments in
time which, upon reflection, should

Ada News’ Progress Edition
looks at past _and present

PROGRESS 2020 SPECIAL EDITION
Friday, April 10 2020

give you an idea of what it was like to
go through this period of upheaval,”
wrote Lewis.

“The idea is that, years from now,
you will be able to pick up a copy of
this edition of Progress, and immedi-
ately be taken back to these weeks,
these months, when life was just ...
different.”
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Pandemic prompts reduction of print
issues at several Oklahoma newspapers

Newspapers are not immune to the
impact of the COVID-19 pandemic.

As businesses closed, advertising
revenue suffered and publishers were
forced to look for ways to save money.

There have been layoffs and fur-
loughs. And there has been a reduction
of print editions. Producing and deliver-
ing newspapers is one of the largest
costs of the business.

Many newspapers that reduced print
issues have expanded their online pres-
ence and are seeing a surge in digital
traffic.

Until this crisis is over, it’s unknown
whether newspapers will resume their
previous print schedules. For now,
they’re making sure they keep their
communities informed, whether in print
or online.

Following are some of the newspa-
pers that announced the reduction of
print issues in their newspaper:

THE ADA NEWS

On April 30, The Ada News stopped
production of the print paper on Wednes-
days and Fridays.

Those two days have been replaced
with expanded electronic versions of the
e-paper.

“Although the total audience of The
Ada News is at a record high as an
essential public service, the sudden
impact of the COVID-19 virus has cre-
ated new challenges,” wrote Marisa Nel-
son, general manager of The Ada News.

“While we are hopeful a recovery
is soon at hand, the economic impact
will be felt for months to come,” Nel-
son wrote in a column announcing the
changes. “As a result, we must make
necessary adjustments to our resources
to preserve our sustainability in the
short term and for generations to come.

“Our news team will continue to
produce all the same local content as
before,” she wrote.

THE DUNCAN BANNER

The Duncan Banner reduced its print-
ing schedule from five days a week to
three days, eliminating Wednesdays and
Fridays.

News, sports and advertising on
those days will appear in the Tuesday,
Thursday and Saturday papers.

“These are stressful times for you,
and for us,” said Crystal Childers, gen-
eral manager of The Duncan Banner.
“As an essential public service for this
region, we have been making our coro-
navirus coverage available, free and
without restriction, to anyone who visits

our website. The result is digital traffic
that has inspired our entire staff.”

THE LAWTON CONSTITUTION

The Lawton Constitution converted
to a five-day publication cycle, beginning
April 25.

“Like many small businesses, the
current business climate is something
I could never have anticipated,” said
David Stringer, publisher of The Consti-
tution. “This was the last thing we want-
ed to consider. However, the impact on
retail and service businesses in south-
west Oklahoma has been devastating,
and their losses affect us deeply as well.”

The Constitution is now published
Tuesday through Friday and has a week-
end edition published on Sundays.

“These changes are designed to
make sure we're around for a long time
into the future,” Stringer said.

“We've made sure the changes will
not impact some of our most read stories
and features. We're just moving them to
a different day of the week. In addition,
beginning in May, we’re going to add
several new magazine features to The
Constitution, including Parade magazine
Sundays.”

Breaking news will still be published
online as it occurs and other news will
be published online first.

“We won’t be waiting until our nor-
mal press time to ‘publish’ the news,”
Stringer said. “We’ve been moving more
and more of our stories to an ‘online
first’ model, and this is an expansion of
that practice.

“Most importantly, we need to make
sure The Constitution is a viable busi-
ness long into the future,” Stringer said.

“All of us who work here know that
we're caretakers of a legacy that began
over a century ago. We're a small busi-
ness, too, and we want to make sure
we're successful enough to pass this
legacy on to the next generation.”

Stringer said The Constitution has
received many messages of support
from the community.

PAULS VALLEY DEMOCRAT

The Pauls Valley Democrat is now
being published once a week on Wednes-
days.

News, sports features and advertising
from the former weekend edition will
be added to the Wednesday paper, said
Mike Arie, editor of the Democrat.

“Readership changes, newsprint pric-
es, print production expenses and deliv-
ery costs have resulted in many commu-
nity newspapers publishing fewer days

“We need fo make sure the (Lawton) Constitution is
a viable business long into the future. All of us who
work here know that we're caretakers of a legacy
that began over a century ago.”

David Stringer , Publisher
The Lawton Constitution

of the week to remain economically
healthy,” Arie wrote in a column.

“Discontinuing our weekend edition
will allow us to focus our resources on
printing more local news in the paper on
Wednesdays.”

POTEAU DAILY NEWS

The Poteau Daily News recently
changed its publishing schedule.

The newspaper is now being printed
three days a week — Tuesdays, Thurs-
days and Saturdays.

“The content is not going to change
just because we're only going to have
three editions per week,” said David
Seeley, editor of the Poteau Daily News.
“The content will still be the same, it will
just be provided in three editions per
week instead of five.”

Seeley assured readers that the
change does not mean the paper is clos-
ing.

“This paper has had a century-plus
tenure of publishing, and we do not have
any plans to change that,” Seeley said.

STILLWATER NEWS PRESS

The Stillwater News Press has halted
production of its print paper on Wednes-
days, Fridays and Sundays.

A weekend edition will be delivered
on Saturday and will include all content
previously received in the Saturday and
Sunday editions.

The former Wednesday and Saturday
editions will be replaced with electronic
versions of the e-paper.

“We remain dedicated and committed
to serving our customers with fact-based
reporting and important information
about the coronavirus and other news
and events from around the Stillwater
area through both print and digital plat-
forms,” said Jill Hunt, publisher of the
News Press.

TAHLEQUAH DAILY PRESS
The Tahlequah Daily Press reduced

its print editions to three days a week —
Saturday, Tuesday and Thursday.

“We are discontinuing the Wednes-
day and Friday papers,” said Gary Jack-
son, publisher of the Daily Press.

“Our commitment to providing Tahle-
quah with helpful local information
during the coronavirus crisis has been
widely appreciated ... as a vital public
service,” Jackson said.

“However, current economic condi-
tions hit the Tahlequah Daily Press
hard. As a result, we must restructure
so we can continue to be your reliable
and primary source for local news in the
future.”

Jackson said e-editions will be pub-
lished five days a week, as usual.

REID NEWSPAPERS

Last month, the Weatherford Daily
News announced it was discontinuing
print editions on Tuesday, Thursday and
Friday during the coronavirus crisis and
putting more effort on its WDN24/7 edi-
tion. The e-edition changes throughout
the day as new information becomes
available.

“When information is updated, staff
will replace images on the front page
and any related pages,” said Phillip Reid,
owner and publisher of Reid Newspa-
pers, which includes the Weatherford
Daily News. “We are excited to bring
this revolutionary concept to our read-
ers.”

The Vinita Daily Journal, also owned
by Reid Newspapers, is currently issu-
ing a print edition twice a week, on
Wednesdays and Saturdays. The Vinita
Daily Journal has opened its paywall to
allow everyone free access to the online
newspaper.

The Perry Daily Journal, also owned
by Reid Newspapers, has discontinued
its Saturday print edition during the
coronavirus crisis. Like other Reid pub-
lications, it is allowing everyone free
access to its online version during the
pandemic.
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Police wait with their weapons drawn during a situation involving potentially dangerous threats made by a
man who allegedly brandished a rifle.

Photo by ASHYLND HUFFMAN, Stillwater News Press, March 24,2020

Bethel’s Jordan Blair competed in Oklahoma’s very first girls wrestling state tournament at the Oklahoma State
Fairgrounds Arena in Oklahoma City. Blair came in second place in the 107-pound weight class.

Photo by JACOB FACTOR, Countywide & Sun, March 5,2020

OG- PHOTO CONTEST

THGETHER

'« betterour comminities

MARCH 2020
DAILY WINNER:

ASHLYND
HUFFMAN

Stillwater
News Press

MARCH 2020
WEEKLY WINNER:

JACOB
FACTOR

Countywide
& Sun

The March 2020 contest was judged
by a member of the
Oklahoma Journalism Hall of Fame.

View all winning photos at
OkPress.com/
OGE-Photo-Contest

ENTER AND WIN A
$100 CHECK FROM
OGE ENERGY CORP.

For more information about the
photo contest, visit
0kpress.com/oge-photo-contest

AT OG&E, WE DO MORE THAN ENERGIZE A POWER GRID.

We energize our communities by volunteering
more than 20,000 hours each year, providing a helping hand.

OGE

We Energize Life

© 2020 OGE Energy Corp.
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YOUR PAGES

A look at some of the pages OPA members have

produced during the 2020 COVID-19 pandemic.
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Special print edition
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Purcell nurse faces COVID-19 on a daily basis

Grimes

The Purcell Register of the COVID-19 tests administered during

her shift or the fate of the patients she treats.

‘The rule of thumb for Rhodes and her co-
workers i treat probables as positives until
testing shows they aren’t.

“We see all kinds of patients,” she said.
“We see COVID, we see trauma — any kind

~ of patient.”

‘The medical center has setup tents outside
to control the flow of patients and separate
the COVID-19 patients from compromised

In the era of COVID-19, it is
good that Myka Rhodes works
better under pressure.
Rhodes,of Purcell, is aregistered
nurse in the emergency department
at OU Medical Center.
She is on the frontline for 12 hours
at a stretch when confirmed or prob-
able COVID-19 patients arrive at the.

hospital. patients.
Itis hospital policy to test every patient When it comes to planning in the midst of
who presents with COVID-19 symptoms.  a pandemic, acquiring personal protective

Those results can be days in coming.
however, and once the patients leave th
emergency department, Rhodes has no con-
tact with them. She never knows dﬂmul

Milestone birthday

Millie Brockhaus celebrates 104!

equipment for staff and supplies needed to

Please sec Front Lines, back page

Grimes
The Purcell Register

Wynnewood, Oklahoma,
April 18,1916.

That’s when Jessy and
Archie Wilson welcomed the
birth of Mildred Florene, the
fourth of their seven children.

On Saturday Brock-
haus celebrated her 104th
birthday at Sunset Estates in
Purcell

Abut 15 of Millies d n-
dants were there, too,albeiton
. John D. Monigomery + The Purell Register | the outside looking in.
Meal time The nursis
forcing a
determined to protect its
vulnerable residents from the
deadly COVID-19.

Millie’s daughter, Suzanne
Clark, said the family ma-
triarch particularly enjoyed
watching the youngest family
members through the window.

“She loves the little ones,”
Clark said.

Birthday greetings were
shared via posters held up to
the glass. Clark brought a big
birthday cake, which staff ac-
cepted at the door.

A memorable birthday cel-
ebration for more than one

Cathy Furniss is the person behind the mask handing out food sacks at Purcell Elementary

Pandemic delay

Regina Clark sentencing reset to July

Grimes
The Purcell Register

The COVID-19 pandemic
will delay sentencing for a
former Purcell woman who
pleaded guilty in February to
18 felonies committed more.
than five years ago.

Regina K. Clark, 53, of

brandished a 357 revolver
at her then-husband, Brett
Clark, and three employees.
He had filed fordivorce three
days carlier.

She fired several shots at

Euliss, Texas, was to have
beeninMcClain County Dis-
trict Court Thursday morning
to be sentenced.

Now she will be sentenced
at 1:30 p.m. July 28

Clark was a co-owner of
Sooner RV north of Purcell
on Dec. 17,2014 when she

~Phota provided
Cake sentiment

Suzanne Clark couldn't be with her mother, Millie
Brockhaus, on her 104th birthday Saturday, but she made
sure Millie had a big birthday cake.

Please sce Delay, back page

Please see 104, back page
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Wesner Publications,
KOSU receive
Facebook grants

Two Oklahoma news organiza-
tions were recipients of the Face-
book Journalism Project’s relief
fund for local news.

Oklahoma recipients are Wesner
Publications in Cordell, OKkla., and
KOSU in Oklahoma City.

Facebook received more than
2,000 applications for the COVID-19
Local News Relief Grant Program
from newsrooms across every state
in the US, all US territories and
Washington, D.C.

More than 200 news organiza-
tions will receive nearly $16 million
in grants.

“The COVID-19 pandemic has
highlighted the critical role local
news plays in our communities,
while simultaneously threatening
their very existence,” said Jonathan
Kealing, chief network officer for
Institute for Nonprofit News (INN).

“Reviewing hundreds of appli-
cations on a tight timeline both
illustrated the depth of need, but
also highlighted the innovation that
these small, independent publish-
ers can provide for their communi-
ties when given the resources.

“I'm excited to see new news
products and more critical original
reporting in these communities,
thanks to Facebook’s support.”

Nearly four in five of the grant
recipients are family- or indepen-
dently owned.

“We’re proud to support this
diverse group of publishers,” said
Campbell Brown, VP of global
news partnerships at Facebook.

“Not only are these journalists
working tirelessly to serve people
right now — they’re focused on
transformation, building innovative
local news businesses that can con-
tinue to serve communities beyond
the current pandemic.”

Oklahoma Watch adds veteran journalists
Streuli and Sherman to leadership team

Oklahoma Watch has announced that
two longtime Oklahoma journalists will
join the nonprofit news organization in
June.

Ted Streuli, former executive editor
and associate publisher for The Jour-
nal Record, has been named Oklahoma
Watch’s executive director and Mike
Sherman, who spent 24 years at The
Oklahoman, will serve as executive edi-
tor. The pair take over the leadership of
the organization from retiring Executive
Editor David Fritze.

Under Fritze’s leadership, Oklahoma
Watch won numerous awards; expanded
fundraising and distribution; fostered
collaborations with other news organiza-
tions; moved into multimedia, and host-
ed numerous public forums on impor-
tant issues in the state.

Oklahoma Watch Board Chairman
Joe Hight said, “We're excited to have
Ted and Mike join Oklahoma Watch.
They are award-winning and nationally
recognized journalists who care deep-
ly about Oklahoma and the important
investigative news stories published by
Oklahoma Watch.”

Streuli has lived in Oklahoma since
2004, when he joined The Journal
Record. Since leaving the news organiza-
tion in 2018, he has served as president

TED STREULI

and executive director of Peaceful Fam-
ily Solutions, a nonprofit that provides
services for children whose families are
affected by addiction.

Sherman returns to Oklahoma from
Tampa Bay, Florida, where he was a dep-
uty editor for The Tampa Bay Times. He
is currently the project manager for The
Coronavirus Storytelling Project, a col-
laboration between three organizations,
including Oklahoma Watch, to help state
journalists who have been furloughed or

MIKE SHERMAN

displaced as well as those in struggling
community news organizations.

“The need for quality, investiga-
tive journalism grows daily with the
announcement of additional layoffs and
furloughs at local papers,” Hight said.
“Oklahoma Watch offers investigative,
fact-driven journalism, that examines
significant issues facing our state. The
work that Ted and Mike will do will lead
to positive change.”

Cole, Mullin support local news amid coronavirus

On April 29, U.S. Reps. Tom Cole and
Markwayne Mullin called on President
Donald Trump and House of Represen-
tatives Leadership to direct financial
support and aid opportunities toward
local newsrooms across the country.

Cole and Mullin, along with 124 other
representatives, sent a letter to Speaker
of the House Nancy Pelosi and House
Minority Leader Kevin McCarthy, ask-
ing that future stimulus funding “include

immediate improvements to existing
lending programs to protect local news
publishers and broadcasters.”
“Throughout our nation’s history,
those involved in reporting and pub-
lishing the news have gone to great
lengths to keep American communi-
ties informed,” said Cole. “Indeed, amid
such emergencies as severe weather
and the ongoing coronavirus crisis,
many journalists have selflessly risked

their own safety and health to chase
down a story and accurately report on
current events. Along with many other
essential roles that have arisen amid
this COVID-19 pandemic, I believe that
it is simply common sense to help local
news sustain and continue their opera-
tions at a time when news reporting is
so critical.”

Report for America journalists to join Oklahoma Watch

Report for America recently
announced the selection of 225 journal-
ists for its 2020 reporting corps, includ-
ing two reporters who will join Oklaho-
ma Watch in June to cover issues related
to poverty and criminal justice.

The national program, an initiative of
The GroundTruth Project, a nonprofit,
said it will place journalists with more
than 160 local news organizations in 45
states and Puerto Rico.

Joining Oklahoma Watch will be
Keaton Ross, a spring 2020 graduate of

Oklahoma Christian College, and Supri-
ya Sridhar, a December 2018 graduate of
the University of Oklahoma.

Ross majored in journalism and
minored in political science and served
as editor of The Talon, the student news-
paper at Oklahoma Christian. His report-
ing on an admissions counselor who led
a racist activity at a high school was
cited by several national news organiza-
tions, including The New York Times.
He has interned at The Oklahoman and
The Norman Transcript.

B2

KEATON ROSS

SUPRIYA SRIDHAR

Sridhar was a magazine intern at
Politico in 2019, where she researched

projects and reported for Politico’s pol-
icy team.

She has interned at The Oklahoman,
The Wichita Eagle and the Louisville
Courier-Journal, where she produced
a story about the national shortage of
emergency medical services workers
caused by burnout and low pay.

She received a bachelor’s in journal-
ism at OU and held leadership positions
at the student newspaper.
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Keep your computer equipment clean with alcohol

w‘ Computer Notes

from the road
by Wilma Newby
wnewby@okpress.com

With a deadly virus floating around
we should be cleaning objects that we
touch every day - keyboards, phones,
mouse, chairs and desktop monitors.

You should be using 70% isopropyl
alcohol to clean this type of equipment
because it doesn’t leave a residue on the
surface.

You can use it for just about every-
thing, but you should look up the manu-
facturer’s instructions for cleaning your
monitor screen. And even if your smart-
phone is rated for water, don’t submerge
it. It's simply too huge a risk.

Never use household cleaning prod-
ucts to clean electronics and don’t use
vinegar instead of alcohol. These sub-
stances could leak into the keyboard
and corrode its components.

Always put the alcohol on a rag or
cleaning cloth instead of pouring it on
the surface of the computer or key-
board.

Use a micro-fiber cloth on monitors
and iPhone screens. Although facial tis-
sues probably won’t damage the screen,
paper towels will scratch the surface.
Instead of vigorously rubbing the
screen, use gentle, wide strokes.

On March 9, Apple stated that you
could use disinfectant wipes on the
iPhone, but they still recommend 70%
alcohol.

Don’t use bleach. Avoid getting mois-
ture in any opening, and don’t sub-
merge your Apple product in any clean-
ing agents.

If you have a gorilla glass screen on
your phone, over time cleaning it with
alcohol will remove a coat of film the
manufacturer applies called “oleophobic
coating.” You may need to buy a kit and
reapply it.

Plastic screens can be destroyed by
household cleaners. If your screen gives
when you push on it, proceed with cau-
tion. Consider putting a wipeable glass
screen protector on iPhone and iPads
for around $10. Inexpensive covers are
also available for keyboards and moni-
tors for easier cleanup.

OFFICE NOW HAS OPTIONS

Microsoft Office 365 is now branded
as Microsoft 365 and has some new
options. Existing accounts will not
change in price and all programs that
were available to computers on that
account will remain the same.

New product names went into effect
on April 21. It starts with the basic web
version now called Microsoft 365 Busi-
ness Basic (formerly Office 365 Busi-
ness Essentials). The user signs in on a

web browser and runs Word, Excel and
PowerPoint through the browser. They
have added features in this version that
are interactive with Microsoft servers
including Microsoft Rewrite, which can
check grammar and sentence structure.
This version is $5 per month.

Microsoft 365 Business Standard, for-
merly Office 365 Business Premium, is
available for $12.50 per month. This is
the most familiar version. It enables five
users with desktop apps on each of the
five computers. This price level gives
access to both Publisher and Access.
And it brings in services such as the
Exchange e-mail client, Share Point and
Teams.

Next up is Microsoft 365 Business
Premium (formerly Microsoft 365 Busi-
ness) for $20 per month. This version
provides cyber threat protection and
device management. It also allows con-
trol over the users’ devices so they can
only save to locations that are approved
by the company.

The last of the business models is
Microsoft 365 Apps for Business (for-
merly Office 365 Business). This ver-
sion provides a business account with
the applications on five computers as
before but without the services and
extra controls over users. It’s available
for $8.25 per month annually, or $10 per
user/per month with a monthly commit-
ment. Please note that the former ver-
sions all require an annual commitment.
This $10 per month option is apparently
available on a month-to-month basis. It
does not include video calling and live
chat that the other plans have.

To figure out what version you have,
log into your Microsoft account online.
Go to Word or Excel and look under File
> Account to find out if it is associated
with a subscription product. There will
be a button that says Manage Account.
The password will be needed to look up
the account information that is linked
to the personal account that someone
purchased.

Adding to the confusion is that there
is Microsoft 365 Family (formerly Office
365 Home) vs Microsoft 365 Apps for
Business — even the price is the same.

Microsoft 365 Personal (formerly
Office 365 Personal) is the least expen-
sive of the home versions at $6.99 per
month. It seems to have the same pro-
grams as the home version. The big dif-
ference is that it will only go on one com-
puter; the home version lets one account
work on six computers. This beats the
Microsoft 365 Business Standard ver-
sion, which only lets five computers use
one account.

The Business Standard has the added
services including Exchange, Share
Point and Teams. The home version
only has Skype. Skype equals the Share-
Point in the business version and Out-

look equals Exchange on the Business
version. They are both email clients.

Microsoft is creating solutions for
business that are entirely cloud based,
much like Google. It’s just a matter of
what company you trust to keep all your
company documents secure.

There is still one avenue to buy
Office and put it on your computer
without a need for a running credit card
account. Office Home & Student 2019
is still available for a one-time purchase
of $149.99. 1t includes Word, Excel and
PowerPoint. There is no email client
(Outlook), Access and Publisher are not
included and no services are offered.
But there’s no monthly fee. It’s the only
one they left the word “Office” in and it
makes me wonder how long it will be
available.

While we're on the sub-
ject of Microsoft programs,
they just released a new
version of their web browser

Edge. This new version even

works on the Mac. Most of the

upgrade seems to be about privacy and

transparency. There are lots of controls
but they seem manageable.

If you're using bing.com for your
home page, it now lets you search with
an image. Just click the visual search
button by the magnifying glass and then
drag a photo into the window. Microsoft
will look for and bring up photos like
it. Google Chrome lets you search by
speaking into a microphone and upload-
ing an image but requires several more
steps.

(9]
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Try Visual Search X

Search with a picture instead of text

o

i@ Drag one or more images here or browse

PHOTOSHOP TIP

Have you ever converted a photo to
grayscale only to find there is an area
that disappears?

Try selecting the object in Photoshop
with the Magic Wand tool. Hold down
the shift key to add additional areas. If
it’s all one consistent color use the Select
menu > Similar. It finds all the pixels that

are the same color and adds them to
your selection. This sometimes works
better than the Shift key method. Once
you have the area selected, use Curves
to darken just that area. Then go to Select
menu > Inverse. Now the background is
selected and can be deleted. You can use
the delete key or go to Edit > Fill and fill
with white. If those methods fail to do it
quickly, try the more time consuming
way of using the Magnetic Lasso tool
to select the object.

If you run newer versions of Creative
Cloud Photoshop go to the Select menu >
Subject Command. This selects the most
predominate item in the photo. It works
great if the thing you're trying to select
is the foremost object. A quick mask
works but to me seems slower than the
above mentioned methods and often
requires more cleanup time.

SOCIAL DISTANCING

Now that social distancing is the rule,
it’s increasingly hard to show someone a
computer screen while trying to explain
a problem. This is the fix.

On a PC hold down the Windows key
while pressing the (+) symbol and the
plus and minus sign zooms out. It jumps
in big increments so be ready for that.
You can move around by going to the
edge of screen with the mouse. They
have a cool toolbox that appears on the
screen for mouse control of the zoom-
ing. On windows it’s controlled under
the Settings > Ease of Access > Maghnifier.

On a Mac go to Apple > System Prefer-
ence > Keyboard > Shortcuts >Accessibility.
The shortcuts are at the top and once
they’re on they are always accessible.

Magnifi.. — X
'
== 100% Views~ o)

To zoom in and out hold down the
Option and Command key, then hit
the (=) or the (-) sign. Option and Com-
mand down and hit the (b) key to turn
on and off the command. Now people
six feet away can see the screen that is
under discussion.

OPA Computer Consultant  Wilma Newby’s
column is brought to you by the Oklahoma
Advertising Network (OAN). For more informa-
tion on the OAN program, contact Oklahoma
Press Service at (405) 499-0020.

\mf JLEGAL ADVICE

s IS jUSt ONe of the benefits of being a member of the Oklahoma Press
? Association’s Legal Services Plan. Remove the worry of needing
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION'S

LEGAL SERVICES PLAN
1-888-815-2672 or 405-499-0020
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OHP releases its vehicular pursuit policy

After years of secrecy, the Oklahoma
Highway Patrol released its vehicular
pursuit policy, placing the document on
its website.

According to the document, the pol-
icy and procedures were updated in
February.

Commissioner of Public Safety John
Scully said in a news release that he
decided to release the protocol because
transparency is a high priority for the
agency’s administration. Scully was
appointed as the Department of Public
Safety’s commissioner by Gov. Kevin
Stitt in September.

In previous years, open records
requests from the Tulsa World were
denied.

In March 2019, the Tulsa World
acquired the policy from the Cleveland
County Clerk’s office after it was used
as a defense exhibit in a felony murder
trial.

In an editorial, the Tulsa World wrote:

“Scully released the policy in an act
of government transparency. Good for
him. Lifting that veil was the right deci-
sion.

“Secrets are bad public policy in gen-
eral. But in law enforcement, there is

an added public safety concern for both
officers and residents.

“Openness doesn’t resolve that issue,
but it avoids magnifying it through
the surmises and conspiracy theories
that naturally result from secrecy. We
applaud the move by OHP to publicize
its pursuit policy and urge it to use that
model broadly in the future.”

The new policy is available on the
OHP website at https://www.ok.gov/
dps/Oklahoma_Highway_Patrol/OHP_
Pursuit_Policy/index.html

Lee, Tulsa World offer business marketing grants

Lee Enterprises, owners of the Tulsa
World, has launched a local market-
ing grant program that offers matching
marketing funds to businesses impacted
by the outbreak of the COVID-19 virus.

Lee Vice President of Local Adver-
tising Joe Battistoni said the program
is available to locally owned and oper-
ated businesses affected by COVID-19
and will provide matching advertising
credits for use in Lee print and digital
publications.

“While our company’s scale is nation-
al, our primary focus has been and

always will be on our local business
communities in the markets we serve,”
Battistoni said.

The grants range from $250 to
$15,000 of matching advertising credits
each month and will be awarded in April,
May and June.

“I am delighted that we are able to
offer this opportunity to our partners
during this critical time and look for-
ward to the positive impact it will have
on the business community,” said Ber-
nie Heller, vice president of advertising
for Tulsa World Media Co.

“For 130 years, our company has part-
nered with local businesses to deliver
their message to the people they serve,
both in times of great prosperity and
in times of great challenge,” said Ray
Farris, Lee operating vice president and
vice president of advertising.

“... the ability of businesses to market
to their customers remains essential to
their sustainability and recovery. Our
company’s greatest assets, by far, are
the local communities we serve, and
we're firmly committed to supporting
them through this grant program.”

Mangum Star names Jacob Factor as edltor

Jacob Factor is the new editor for the
Mangum Star.

Factor attended Oklahoma Baptist
University, majoring in journalism and
mass communication. He was a staff
member for the student publication, The
OBU Bison, while attending college.

He interned at the Luther Register
News and the Sequoyah County Times.

Factor worked at the Countywide and

Sun as a sports reporter as well as a
news reporter for more than a year.

He also served as a page designer
for the Mclntosh County Democrat for
a year.

“I'm so excited for this new adven-
ture,” Factor said. “I'm a bit shocked that
I'll be the editor of a paper at 22 years
old, but I can’t wait to see where this
path takes me.”

UNITEDSWITH YOU

Together
we help
one another.

WORTH
MENTIONING

QUARANTINE ACTIVITY BOOK

The Henryetta Free-Lance
and Okmulgee Times included a
special publica- [7 f
tion, The Quar-
antine Activity
Book, in their
April 29 edi-
tions.

The book
included a vari-
ety of puzzles
including word search, Sudoku,
crosswords and more, sponsored
by local county businesses.

ANNUAL GRADUATION SECTION

The Clinton
Daily News
published its
annual gradua-
tion section on
May 9.

When the
newspaper put
out a plea for
assistance in
finding spon-
sors for this
year’s area
high school
graduates,
people responded. Every high
school student from Clinton and
Arapaho-Butler were selected by
local businesses and individuals.

“That’s simply phenomenal con-
sidering the uncertain times we
are all facing,” said Sean Stephens,
assistant publisher and sales
director. “It just shows that while
a global pandemic has taken so
much away from us and especially
our graduates, people still felt com-
pelled to honor these kids for their
achievements and what they mean
to the community.”

SENIOR YARD SIGNS

Many news-
papers, includ-
ing the Enid
News & Eagle,
are selling yard
signs to honor
graduating
seniors.

The News
& Eagle made
signs available
for only $30.
The 18"x24”
signs were
available in
the graduates’
school colors.
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MARGUERITE BABB, a former editor for
the Jenks Journal, died April 28, 2020.
She was 90.

Babb was born in Tulsa and gradu-
ated from Webster High School in 1947.

DEATHS

She was editor of the Jenks Journal
from 1967-1972.

She enjoyed traveling and was able to
visit her favorite place, Hawaii, several
times.

Babb is survived by three children,
Belinda Sands of Broken Arrow, Larry
Peninger of Taft, and Beverly Vogt of
Tulsa; four grandchildren and six great-
grandchildren.

DENNIE HALL, a respected journalist,
journalism professor and historian, died
April 17, 2020. He was 85.

Hall was co-founder of the Oklahoma
Journalism Hall of Fame and served as
its director. The recently published book
“Our Greatest Journalists: Fifty Years of
Oklahoma Journalism Hall of Fame” is
dedicated to him and Dr. Ray Tassin.

Hall was the longtime adviser to the
University of Central Oklahoma’s stu-
dent publication, The Vista, and known
for supporting his editors against

attacks from the administration. The
student newspaper was named an All-
American College Newspaper for the
first time while he was adviser.

He was The Oklahoman’s book edi-
tor, known for his reviews and help-
ing great future authors. He fought for
civil rights, First Amendment freedoms
and the downtrodden, especially those
wrongfully imprisoned.

He was a grammar and Associated
Press style guru with a dry sense of
humor. If you said you were making

an “advance reservation,” he would
look over his glasses, smirk, and reply,
“That’s the best kind.”

He was preceded in death by his wife
of 55 years, Ann Mathews Hall.

He is survived by his son John Hall of
Edmond; daughter Amy Hall of Edmond,;
brothers and sisters, Mickey Hall, of
Water Valley, Miss; Karen Hall Dye, of
Olive Branch, Miss.; Patricia Hall Yar-
brough, of Memphis, Tenn.; Jimmy Hall,
of Horn Lake, Miss.; three grandsons
and one great-granddaughter.

JAKE NORMAN McDONALD, who
worked as a journalist in Weatherford,
OKla., died April 1, 2020, in Norman. He
was 28.

Born Aug. 20, 1991, McDonald gradu-
ated from Norman North High School
in 2010. He attended classes at the

University of Central Oklahoma and the
University of Oklahoma.

For a short time he worked as a
reporter for the Weatherford Daily
News.

He is survived by his mother, Alice
Stanton; father William Henry McDon-

ald; stepfather Joseph Mashburn;
brother Alec McDonald; sister Laura
Mashburn; his grandparents, aunts and
uncles, godparents and devoted girl-
friend Jessica Potter.

NANCY JANICE ‘JAN’ OQ’LEARY, a
former employee and co-editor of The
Hooker Advance, died April 23, 2020.
She was 78.

O’Leary was born Nov. 26, 1941, in

Mitchell, Ark. She married James E.
‘Jim’ O’Leary in 1965.

The family moved to Hooker in 1975
and Mrs. O’Leary worked for The Hook-
er Advance. The family moved to Hous-
ton in 1988.

After her husband retired, the couple
moved to Van Buren, Ark.

She is survived by two sons, Bruce
O’Leary of Wylie, Texas, and Brent
O’Leary of Rockwall, Texas; one sister;
three brothers and six grandchildren.

FREDERICK DAVID SEATON, longtime
publisher of the Winfield Daily Courier
in Kansas, died April 18, 2020. He was
80.

Seaton was born June 16, 1939, in
Manhattan, Kan. He graduated from
Harvard University and later earned
a master’s degree from the Columbia
University School of International and
Public Affairs.

After serving two years in the Peace
Corps and working as a press secretary
and legislative aide in Washington, D.C.,

Seaton moved to Winfield and went to
work for Winfield Publishing Company,
part of the Seaton Newspaper Group,
which has seen four generations of fam-
ily members operate newspapers in Kan-
sas and other states.

Seaton served as editor and publisher
of the Winfield Daily Courier from 1981
to 2009. During that time, the com-
pany purchased the Newkirk Herald
Journal in Oklahoma and the Arkansas
City Traveler. Seaton remained an active
owner and was chairman of the board

for Winfield Publishing at the time of
his death.

Seaton served as president of the
Kansas Press Association in 1991 and
was inducted into the KPA Hall of Fame
in 2010.

He is survived by his wife, Callie;
daughters Elizabeth G. Seaton of Alma,
Kan., and Rebekah C. Seaton of West
Hartford, Conn.; son David A. Seaton of
Arkansas City, Kan.; and seven grand-
children.

IN MEMORY OF OUR FRIENDS & COLLEAGUES WHO DIED THE PREVIOUS YEAR

Harold Wayne Hawkins
April 21,2019

Imogene ‘Jean’ Hewitt
April 12, 2019

Steve Jump
April 13,2019

Mary Sue Pena Norman
April 1, 2019

Kenneth D. Kiser Jr.
May 8, 2019

Please donate ..o

A donation to ONF will support its efforts to improve the state’s newspaper industry and quality of

journalism. ONF’s programs include training and education for professional journalists, scholarship

and internship programs for journalism students, and Newspaper in Education efforts. ONF relies on
donations and memorial contributions to fund these programs. If you would like to make a

donation, please send a check to:

OKLAHOMA NEWSPAPER FOUNDATION, 3601 N. Lincoln Blvd., Oklahoma City, OK 73105
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OKLAHOMA NATURAL GAS CONTEST WINNERS

CONGRATULATIONS TO THE MARCH WINNERS
March Column; ART HADDAWAY, Owasso Reporter

March Editorial: . D. MEISNER, Cushing Citizen

MARCH COLUMN WINNER
ART HADDAWAY, Owasso Reporter

Staying informed, encouraged and relaxed

The last couple weeks have played out like a
scene from a post-apocalyptic movie.

That's a sentence | never thought | would have to
write.

Local retailers have limited their clientele,
restaurants have shut down and gone to curbside
or delivery services, and residents have retreated
inside their homes to avoid social interaction — so
much for a good start to 2020.

It all happened so fast: One minute I'm familiarizing
myself with the term “coronavirus,” and the next I'm
juggling sources and rushing through stories trying
to play catchup with every update thrown my way.

Covering this pandemic is a first for me, and it's
probably a first for many people, especially my
media counterparts — and we news folk see a lot.
I've been in the throes of devastating flooding and
tornadoes, police standoffs, teacher walkouts and
more, but this one takes the cake.

It's uncharted territory, and we’re all in a sort of
limbo awaiting the next bit of news (hopefully good)
from medical experts and government officials.

The numbers of COVID-19 are sobering: As of
Monday, March 23, Tulsa County has seen 11
positive cases and one death; Oklahoma has
confirmed 81 cases and two deaths; the U.S.

has encountered 41,511 positive cases and 573
deaths; and globally, there are a reported 372,563

Oklahoma
Natural Gas.

A Division of ONE Gas

AR

positive cases and 16,381 deaths, according to
the Tulsa Health Department, Oklahoma State
Department of Health and Associated Press.

Skeptics look at those figures and underestimate
the true scale of the spread; others see them and
exacerbate the details, convincing themselves and
others that this is the end of humankind.

Either way you break it down, this is a trying time
that should be taken seriously, but one that I'm
certain we'll bounce back from, much wiser and
stronger than before.

In the days ahead, my hope is to keep you up

to date with the latest information about the
pandemic, but to also share stories of hope amid
the chaos. It's important to stay informed, but it’s
equally if not more important to stay encouraged.

Whether you're hunkered down at home or stuck
in your cubicle at the office, use this hiatus to do
something productive and refreshing rather than
exhaust yourself by worrying and criticizing.

My plan: to put pen to paper (of course), but to
finish “Into the Wild” written by Jon Krakauer, make
s’'mores by the fire pit, binge-watch “The Office”
with my wife, eat some delicious local takeout and
catch up on some much-needed R&R.

Oh, and to pray. The world needs a lot of bent-
knee intercessions with the man upstairs right
about now.

-

Oklahoma
Natural Gas.
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Enter and Win
a $100 Check
from Oklahoma
Natural Gas!

The March 2020
Oklahoma Natural Gas
Column and Editorial Contest
was judged by a member of the
Oklahoma Journalism Hall of Fame.

1. Each month, send a tearsheet or
photocopy of your best column and/
or editorial to Oklahoma Natural Gas
Contest, c/o OPA, 3601 N. Lincoln
Blvd., Oklahoma City, OK 73105-5499.
Entries also may be emailed (full-page
tearsheet) to news@okpress.com.

2. Include the author’s name, name of
publication, date of publication and
category entered (column or editorial).

3. Only ONE editorial and/or ONE column
per writer per month will be accepted.

4. All entries for the previous month must
be at the OPA office by the 15th of the
current month.

5. Winning entries will be reproduced on
the OPA website at www.OkPress.com.

Entries must have been previously
published in print. Contest open to
all OPA member newspapers.

Although Oklahoma Natural Gas Company
selects representative contest winners’
work for use in this monthly ad, the views
expressed in winning columns and editorials
are those of the writers and don’t necessarily
reflect the Company’s opinions.

Thank you for continued

support of “Share The Warmith”
Read the Winning Columns & Editorials on the OPA website:
www.OkPress.com (Under Contests)



